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INSTALLATION
This library requires Kontakt 5 or later.   

If you do not own Kontakt, you will need to download and install the free 

Kontakt player which you can do here ; Kontakt Player Download Link

TO ADD THE LIBRARY AND AUTHORIZE IN KONTAKT

1. Make sure you have updated Kontakt 5 to the latest version in NI service 

Center. 

2. Then, start Kontakt or Kontakt Player in standalone mode (ie. not as a 

plug-in). Then open the Browser on the left (the folder Icon at the top).  

3. In the Libraries tab at the top of the browser go to "Add Library"

4. Click and use the dialogue window to navigate to and point Kontakt to the 

location of the EP73  Deconstructed > EP73 Library folder.  This will add it to 

the Kontakt Library list AND to the Service Center.

5. If Kontakt asks you to Activate the library, the NI Service Center program 

will launch and you will need your serial number to authorize EP73. (you can 

find your serial number in your soniccouture account, next to the product 

download.)

6. If Kontakt doesn't ask you to authorize, you can force it to by clicking the 

little "Activate" button in the upper right corner of our EP73  Library graphic, 

in the Browser/Libraries list. It will then prompt you to launch the Service 

Center.

After authorization, you should restart Kontakt. 

If you experience any problems, you will probably find the answer on our 

FAQ page.
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DECONSTRUCTING A RHODES

After the success of our Xtended Piano project, we decided to explore this 

concept with another instrument; the ever-popular Fender Rhodes. We 

decided to try and find the oldest instrument we could lay our hands on, and 

found ourselves purchasing a 1973 Stage 73 Mk1 model.

As this is a very early Mk1, there are some differences between it and the 

MkII that are not so defined between the later models (which tended to be 

largely cosmetic). These earlier Mk1s tend to sound a little darker, ever so 

slightly softer, and definitely more “vintage” sounding.  Our Mk1 has the old 

wooden hammer/key design, which a lot of players still lust after.

The instrument we bought needed a fair amount of work before it was 

playable, so the first job was to replace all the dampers and hammers, as 

well as a couple of pickups.  Once this was done, we started exploring.
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When the cover is removed, you can see all the tonebars like this:

The entire harp can be raised up exposing the tines and pickups beneath:

The hammers would usually strike the tine 

portion of the Rhodes “tuning fork” 

system. The tine vibrates in front of a 

magnetic pickup (the red coils in this 

photo), but when raised vertically like this 

the hammers don’t reach the tines.
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The tuning fork assembly is basically 

constructed of three parts: the 

“tine” (which is struck by the hammer), 

the tonebar (which resonates together 

with the tine) and the assembly base 

that hold the two together.

EXTENDED TECHNIQUES

On of the first things we tried doing was bowing the tines. This proved a little 

bit more difficult than bowing the piano since the tines are so short and stiff.   

It’s difficult to get enough friction to keep them resonating, so we had to 

make longer and thicker bows than we used on the grand piano. Once we 

got this working, however, it gave us a really nice, slightly spooky, sustained 

sample.

Plucking the tines with a guitar pick was the next ‘obvious’ technique, and 

this gave a really nice gentle sound, a bit like a metal harpsichord. ( As usual, 

Soniccouture prefer Jim Dunlop™ USA Nylon picks when plucking 

instruments that are not made to be plucked.)
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Next we found ourselves a tiny steel jeweller’s hammer, and started hitting 

the tuning fork assembly in various different places.   We ended up sampling 

the steel mallet hitting the tine, the tonebar, and the base of the assembly.

As well as this, we banged and beat the case, 

bounced marbles down the tonebars, and 

committed various acts of abuse to make a 

collection of special effects that wouldn’t be 

pitched, but could perhaps be useful.

So in the end we ended up with four complete sets of samples: Bowed 

Tines, Plucked Tines, Mallet Tines, and Special FX.

But there was still one thing missing; the keyboard...
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RETRACTED TECHNIQUES

So if we were going to sample the keyboard of the Rhodes, what signal 

should we record?

In addition to the line out of the instrument, we placed a microphone above 

the tonebar to capture the acoustic sound of the Rhodes (as well as lots of 

hammer noise), and we used a contact mic to capture a slightly different, 

physical kind of signal from the instrument, rather than magnetic.

This gave us three mono channels simultaneously, the standard Line Out, 

the Microphone, and the Contact Mic.

In truth, many Rhodes players used to mic the tonebars during recording 

sessions since it added a physical aspect to the sound (and was probably 

closer to what they heard themselves) than simply using the line out. They 

probably didn’t get the mic quite as close to each tine as we did, but the Mic 

signal definitely provides that acoustic “clunk” of the Rhodes if you need it.
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KONTAKT 
INSTRUMENTS
EP73  (Deconstructed)  consists of five main instruments: Stage 73 Bowed, 

Stage 73  Keyboard, Stage 73 Mallets, Stage 73 Plucked, and Stage 73 SFX.   

On the top level of your Instruments folder you’ll find one of each of these.   

In the Electric Piano Presets and Sound Design Presets folders you’ll find 

about a hundred more Instruments, but all of them are based on one of 

these five main types.

In the Library Browser, the Instrument window appears like this:

Note that if you are inside a 

subfolder, like Sound Design, you 

can go back to up a level by 

double-clicking on the folder’s title 

at the top.
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STAGE 73 KEYBOARD

The Stage 73 Keyboard instrument is the “natural” Rhodes, i.e. we sampled 

this one using the Rhodes’ own keyboard.   

You can see at the bottom there are three tabs; Options, Instrument, and 

Effects.  The Options page provides some preferences, and the Effects page 

is obviously for the effects, but the Instrument page is where most of the 

action is.    You will find these three tabs in all EP73 presets, although the 

content of the Options and Instrument page varies somewhat depending on 

the instrument type.

Across the top of the Instrument panel for Stage 73 Keyboard you see three 

large knobs. These are the levels for the three main signals we sampled; 

Line Out, Microphone, and Contact Mic.   The title above the knobs 

functions as an on/off switch for that channel, so you can quickly hear the 

presets with or without that channel and not need to change the level.

The Line Out is the normal Rhodes signal that would usually be routed to a 

speaker.   The Microphone is the signal from a microphone placed above the 

tonebars, and the Contact Mic was attached directly to the tonebar.   These 

are obviously unusual signals and are usually best mixed together with the 

Line Out, although you can of course adjust them however you like.
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Below the three main knobs you can see some more controls. From left to 

right : Tremolo depth, the Filter section, the Envelope section, and the Key 

Off level.

The Tremolo depth is exactly that, the depth of an LFO to the level of the 

signal, which we call tremolo (although on some old electric pianos it was 

sometimes called vibrato).   The Rhodes we sampled doesn’t actually have 

Tremolo, but this is a very typical and suitable effect.

THE FILTER SECTION

The filter section is identical in all presets in EP73.

In the Filter section you have 

control of the Frequency of the 

cutoff, the Resonance, the FEG 

(Filter Envelope Generator depth), 

and the Velocity to the filter cutoff.

Note that FEG and VEL are bi-directional, so to have no they are at zero 

when at 12 o’clock.

THE ENVELOPE SECTION

The envelope section is identical in all presets in EP73.

Here we find Attack, Decay, Sustain, 

and Release, your standard ADSR 

envelope for the sound.   By default, 

this is adjusting your Amplitude 

envelope.   

To the right of those there is a small LED called FEG, this switches the 

controls to the Attack, Decay, Sustain, and Release of the Filter envelope.

TIP: With all knobs you can Command-Click ( or Control-click in 

Windows) to instantly set a knob back to it’s “default” position.
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On the far right, we find the Key Off knob. This adjusts the 

level of the noise the dampers make when you release a key.   

(It’s a slight clunk as you hear the note being damped.)

This is very nice for realism, but if be aware that this will always happen at 

the exact time you release a note, so if you’re making a preset that has a 

long envelope release time, this might be inappropriate.

EDITING EACH CHANNEL

To the right of the three large level knobs you can see a small LED called 

Edit.  This opens up a window with several options for each channel.   When 

Edit is on, some more smaller knobs appear beneath the large knobs.

The first of these is Tremolo Speed, which adjust the rate of Tremolo.

Then there are slightly different controls for each of the main signals.   You 

can see above that for the Microphone signal there is and LPF (Low Pass 

Filter), and an HPF (High Pass Filter).   For the Line Out and Contact Mic 

there is a SAT (Saturation level) and an HPF (High Pass Filter).   

These small knobs vary a little bit from one instrument to the next, 

depending on what we thought was most useful for each signal.     But they 

will always be one of HPF, LPF, Saturation, or Pan.

                                              

TIP:  When the Kontakt Info pane is activated, you can hover your 
mouse over any control to get information about its function
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THE OPTIONS TAB

The Options tab allows you to set up some performance preferences for the 

instrument.   This varies slightly for each instrument type.

At the top of this tab we have the Velocity Setup area.   Here you can control 

the velocity SENSITIVITY, which is the amount of velocity to volume, and the 

CURVE of the velocity response.   Below the graphic representation of the 

curve are two controls for minimum and maximum velocity output.   Usually 

you would leave this at 1 and 127, but you could use this to limit the output 

range of the velocity.   For example, if you lowered the maximum to 100, you 

wouldn’t be able to hit the very loud samples of the Rhodes, no matter how 

hard you hit your keyboard.

RAM MANAGEMENT

In the bottom half of the panel there are three sections.   On the far left we 

have the RAM Management section.   EP73 puts a lot of sample data at your 

disposal, but you may not need all of this detail, especially if your computer 

has limited RAM resources available.   In this section you can set each of the 

Stage 73 Keyboard channels (the big knobs on the main page) to use either 

1 Layer, 3 Layers (round robin), or to be completely off (Unload).

Remember that if you Unload a sample set, you won’t be able to hear it, no 

matter what the setting of the Level knob on the Instrument tab.
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In this example, the Microphone channel is set to use just one Layer, the 

Line Out is set to use 3 Layers (round robin), and the Contact Mic is off.

PEDAL

The pedal section is in the middle lower half 

of the Options tab.   These are functions 

related to the sustain pedal behaviour of the 

instrument.   There are two main controls 

here:

RESONANCE.    When you hold down the sustain pedal on a piano, and play 

a note, it sounds very different from when you play the same note with the 

sustain pedal up.   This is because of sympathetic resonance between the 

strings.   The same is true of a Fender Rhodes, when the sustain pedal is 

down you hear a lot of sympathetic resonance in the harp that you don’t 

hear when the sustain pedal is up.   

We’ve modeled the sympathetic harp RESONANCE with this knob.  When 

it’s off (at zero) the effect is bypassed, otherwise the RESONANCE knob sets 

the amount of sympathetic resonance of the Rhodes harp.

WARNING!   

PEDAL RESONANCE is  extremely demanding on your CPU, so be 

aware of this when you bring it up. If you get crackles or distortion 

of some sort when using RESONANCE you may need to either 

increase the playback latency of your system or else just turn it off 

again. It’s off by default in all our presets because of this, so only 

use it if your computer is up to the task.
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The pedal also makes a bit of a clunky noise as it goes up and down.   This 

level is controlled with the NOISE knob in the Pedal section.   This doesn’t 

require much CPU at all, so don’t worry about that.

The entire PEDAL system can be turned on or off with the LED above it.

NOISE

The Rhodes Line Out generates a certain amount 

of noise, basically RF buzz.   You can turn this on if 

you like with the Noise LED and adjust it’s volume 

with the knob. It’s not a very pleasant noise, but it’s 

there for realism if you want it.

There are some slightly different Options in the other main Instrument types, 

which we’ll get to when we cover those Instruments a bit later.

TIP: Remember that all knobs  in our Instruments  can be 

automated, either by MIDI or by host automation. Often the 

quickest way to automate a knob is to right-click on it and move 

the controller that you want to assign to that knob.

SONICCOUTURE EP73 DECONSTRUCTED USER GUIDE

www.soniccouture.com                                         email :customerservices@soniccouture.com

http://www.soniccouture.com
http://www.soniccouture.com
mailto:customerservices@soniccouture.com
mailto:customerservices@soniccouture.com


THE EFFECTS TAB

The effects tab is identical in all the EP73 Presets.

Here you’ll find a great many effects that you can adjust on the preset.   

The top half of the panel has six tab switches for AUTO-WAH, AUTO-PAN, 

CHORUS, PHASER, DELAY, and REVERB.   When you click on the coloured 

tab, you select the controls for each of those.

In the bottom half you have controls for a COMPRESSOR, a CABINET 

(loudspeaker) selection, an EQUALISER, and TAPE DRIVE.

The effects are primarily insert effects except for the DELAY and REVERB, 

which are send effects.   The order of these effects is as follows:

Let’s start with the tab effects.
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All effects have an LED at the far right which turn it on or off.

AUTO WAH 

AUTO-WAH is a modulated filter effect. 

FREQUENCY sets the frequency around which the modulation occurs. Use 

it to find the modulation sweet spot.  Resonance controls the filter 

resonance to emphasize the wah-wah effect. Rate controls the modulation 

rate in Hz when the Sync button is off and in tempo-synced note divisions 

when the Sync button is on.

AUTO PAN

AUTO-PAN has DEPTH and RATE controls to set the LFO amount and 

speed of pan modulation. Here too, the rate can be set in Hz or tempo-

synced note divisions by using the SYNC button on the far right bottom.
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CHORUS

The CHORUS is a standard chorus fattening effect, and gives you three 
controls.  MIX adjusts the level, DEPTH and RATE control the amount and 
speed of the modulation.

PHASER

The PHASER is another famous effect, especially in 70s music, in which the 
phase of the sound is varied over time to create a liquid, swirling effect.    
Here you can again adjust the MIX level, the DEPTH and RATE of the effect.

DELAY

An effect which creates echoes of the original sound.  MIX adjust the level of 

the effect.   TIME is either in milliseconds or in 16th notes, depending on the 

SYNC button on the far right.   FEEDBACK creates cascading copies of the 

delay, as it feeds back into itself.
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REVERB

The REVERB is based around Kontakt’s convolution processor, and can 

provide both realistic spatial reverberation of natural spaces, or more 

creative, FX-style textures and effects.

Choose an impulse response from the drop-down menu.   The top half of the

list features natural spaces, the lower half are the special effects.  

You can vary the amount of reverb applied using the MIX knob.   The SIZE 

knob can increase or decrease the default size of the apparent reverb by 

lengthening or shortening the impulse response.

OUTPUT EFFECTS

On the bottom of the Effects tab you have four more effect sections.   From 

left to right these are:

COMPRESSOR

This controls the amount of compression, and is bypassed when turned all 

the way to the left.  When you adjust this knob you are actually adjusting the 

threshold of the compressor. If you hold down ALT or OPTION on your 

keyboard, you can adjust the ratio of the compressor as well.
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CABINET

Choose from a drop down menu of various loudspeaker cabinets.   You can 

also adjust the BASS and TREBLE response of the cabinet.   The entire 

section is turned on or off with it’s own LED.

EQUALISER

This is a three band EQ (the new Solid Gold EQ in Kontakt 5).   Here you 

adjust the gain of three bands, LOW, MID, and HIGH.

If you hold down ALT or OPTION on your keyboard you can adjust the 

frequency of those bands.

TAPE DRIVE

This is a control for the new Tape Saturator effect in Kontakt 5.   The knob 

adjusts the gain of the drive.

If you hold down ALT or OPTION on your keyboard you can adjust the 

warmth of the effect.
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STAGE 73 BOWED

STAGE 73  BOWED is an instrument made by bowing the tines of the 

Rhodes piano. There are two main knobs on the top of the main Instrument 

tab, which provide level controls for the BOWED TINE, and the BOW NOISE 

itself.  The titles of those large knobs also function as on/off buttons for that 

channel.

In the bottom half of the screen you see controls for TREMOLO, FILTER, and 

ENVELOPE  (There are no KEY-OFF samples when you use Bowed Rhodes).

These are the same controls as found in the keyboard instrument.   The 

TREMOLO is the depth of Tremolo.   The Filter controls are explained here.   

The Envelope controls explained here.

When the EDIT LED is enabled, some more controls appear, like this:
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Now you can adjust the PAN and the HPF (High Pass Filter)  of either of the 

main two channels with the knobs directly below them.    On the far left you 

can adjust the TREMOLO SPEED.

You’ll also notice a new LED called LAYER.

When LAYER is turned on the Bowed samples are duplicated, and you can 

DETUNE them, resulting in a thicker sound. The WIDTH knob spreads the 

two LAYERs apart in the stereo field.

THE OPTIONS TAB

The Options tab in Stage 73 Bowed is similar to the one in Stage 73 

Keyboard (covered here), except that there is no RAM Management section.   

(Bowed Rhodes doesn’t require very much RAM.)

Instead, in the lower left corner you’ll see a GLISSANDO section.
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GLISSANDO

The GLISSANDO effect is a continuous pitch shifting of the sound.   It is 

turned on or off with the LED at the top left.

The AMOUNT knob controls the direction, as well as the amount, of pitch 

shift.   When it’s at 12 o’clock, there is no pitch shifting.   When it’s turned 

higher the pitch glides UP, when it’s turned lower, the pitch glides DOWN.

The TIME control adjust the speed of the glissando effect.

THE EFFECTS TAB

The Effects tab in Stage 73 Bowed is identical to all presets in EP73.   The 

Effects panel is covered in detail here.
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STAGE 73 MALLETS

Stage 73 Mallets is an instrument made using a tiny steel hammer.   We hit 

three different places on the Rhodes tuning fork to get slightly different 

metallic sounds.   The three main knobs on this panel allow you to adjust the 

level of the three different types of sound.    These are the TINE itself, the 

TONEBAR, and the ASSEMBLY (the base of the assembly bracket).

The titles above these knobs also function as switches, allowing you to turn 

the channel on or off without adjusting it’s level.

Below the three main knobs you can see some more controls.   These are, 

from left to right: Tremolo depth, the Filter section, the Envelope section, and 

the Key Off level.    These are identical to the Stage 73 Keyboard instrument, 

and are covered here.

When you click on the EDIT LED to the far right of the large knobs, you open 

a window that allows you to edit a few extra parameters.   These include the 

TREMOLO SPEED, and a PAN and HPF (High Pass Filter) for each of the 

three channels.
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THE OPTIONS TAB

The Options tab in Stage 73 Mallets includes a RAM Management section, 

and is identical to the Stage 73 Keyboard Options.  Those are covered here.

THE EFFECTS TAB

The Effects tab in Stage 73 Mallets is identical to all presets in EP73.   The 

Effects panel is covered in detail here.

SONICCOUTURE EP73 DECONSTRUCTED USER GUIDE

www.soniccouture.com                                         email :customerservices@soniccouture.com

http://www.soniccouture.com
http://www.soniccouture.com
mailto:customerservices@soniccouture.com
mailto:customerservices@soniccouture.com


STAGE 73 PLUCKED

Stage 73 Plucked is an instrument made by plucking the Rhodes’ tines with 

a guitar pick.   This only has one channel, but for consistency we left the 

LEVEL knob in the middle of the Instrument tab, as see above.

The lower part of the Instrument tab includes TREMOLO, a FILTER section, 

an ENVELOPE section, and KEY OFF Level.   These controls are identical to 

the Stage 73 Keyboard version, the full explanation of which can be found 

here.

When you click the EDIT button beside the level knob you open up some 

extra controls, like this:
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These include a knob for the TREMOLO SPEED (far left), and a 

SATURATION and HPF (High Pass Filter).    It opens up a LAYER switch and 

some controls for that.

When LAYER is turned on the plucked samples are duplicated, and you can 

DETUNE them, resulting in a thicker sound.   The WIDTH knob spreads the 

two LAYERs apart in the stereo field.

THE OPTIONS TAB

At the top of the Stage 73 Plucked Options tab we have the VELOCITY 

SETUP, and down below we have a STRUMMER, a PEDAL section, a 

PLUCK section, and a NOISE section.

The VELOCITY, PEDAL, and NOISE sections are identical to those in the 

Stage 73 Keyboard Options, and are explained here.

There are two unique options in Stage 73 Plucked however.
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First, on the far left we have the STRUMMER.

The STRUMMER allows you to strum a chord using a MIDI controller, such 

as the Mod Wheel.   It’s set to use the ModWheel by default, so if you hold 

down a chord, and move the ModWheel you should hear the notes you’re 

holding down strummed across a wider range than you are holding (the full 

range of the instrument).

It’s turned on and off with the LED at the top left.   The MIDI CC you want to 

strum with can be altered in the little number box.   The STRUM knob simply 

mimics the behaviour of the strum controller.   The RANDOM knob 

introduces some random offsets to the velocity of the notes generated by 

the STRUMMER (starting from the velocity of the notes you played).   

There are also two LEDs:    MUTE INPUT stops the MIDI you’re playing from 

being throughput to the instrument, so that you only  hear the output of the 

STRUMMER.    INVERT turns the controller upside down, so that if the 

ModWheel was strumming from bottom to top, you could make it strum 

from top to bottom.

PLUCK LATENCY

We also have one other unique option in the Stage 73 Plucked instrument, 

which is control over the Pluck Latency.    When you pluck an instrument (be 

it a guitar or anything else)  there is typically some noise from the plectrum 

before the string actually begins sounding.   However, if you edit the sample 

when the string starts sounding, it generally sounds a bit artificial, a bit too 

percussive.   If you edit the sample at the point at which the plectrum starts 

scraping, the onset of the sound tends to be a bit late, but more realistic.
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The Pluck Latency gives you some control over this.   When it’s set to 0 ms, 

the attack is right at the transient, which is slightly percussive.   As you bring 

it up, you are introducing some latency, but starting the sample earlier, 

before the transient, to allow some of the plectrum noise through.

This sounds nicer, but will be late.   So if you use the Pluck Latency, it’s often 

best to shift your MIDI tracks earlier in your sequence by the same amount 

of time as the latency... then they will be in time with your other instruments, 

but have the full natural pluck sound.

THE EFFECTS TAB

The Effects tab in Stage 73 Plucked is identical to all presets in EP73.   The 

Effects panel is covered in detail here.
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STAGE 73 SFX

Stage 73 SFX is a bit different from the other instruments in this collection.   

It consists of 127 different special effects, a different one on each MIDI key, 

made by hitting, rubbing, and just generally abusing the Rhodes in some 

way or another.    (Some of these effects are looped and some are not.   The 

notes on the keyboard display in red are those that are looped.)

Since each key is a different effect, it’s not generally intended to be used as 

a chromatic musical instrument, although as we’ll see there are some 

situations in which it can be.

In the middle of the upper layer we have the big knob for LEVEL.   But to the 

right of that you’ll see a panel which has two LED switches:  EDIT SINGLE, 

and FOCUS.

When EDIT SINGLE is enabled, you are only editing the last note you played  

(It’s name is displayed in the window beside the word “KEY”.)    So you if 

you adjust the attack time on C3, you won’t be changing the attack time on 

any of the other notes (SFX).
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If you turn this off, the text changes to EDIT ALL, and in that case you are 

editing all the sounds at once.   This is very handy as well of course, 

especially if you want to reset everything to a natural starting point   

(remember Command/Control Click!).

The FOCUS button is rather special.  When the FOCUS button is turned on, 

the last sound effect you played is spread across the entire keyboard and 

centred on middle C.

If you have the Keyboard display enabled, it will turn green, like this:

This helps remind you you’re in FOCUS mode.    While in FOCUS mode you 

play a single sound effect as if it were an instrument.   You can save an 

Instrument in FOCUS mode.

The controls below are almost the same as in the Stage 73 Keyboard, but 

can be set differently for each SFX if not in FOCUS mode.   The one control 

that’s different for Stage 73 SFX is the TUNE knob in the bottom right.   The 

rest of them are explained here.
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The TUNE knob is a pitch control.

THE OPTIONS TAB

The Options tab of Stage 73 SFX has the Velocity section at the top, which 

is the same as in other instruments and explained here.

Below that there are two switches in a panel called KEYZONES.

The SHUFFLE switch randomizes the order (layout) of the different SFX 

samples on the keyboard.   This is fun for exploring, since you quickly will 

have a completely different set of samples under your fingers.

RESET sets the keyboard mapping back to it’s original state.

Neither SHUFFLE nor RESET are audible if the instrument is in FOCUS 

mode, since while in FOCUS mode only one sample is mapped across the 

entire keyboard.

THE EFFECTS TAB

The Effects tab in Stage 73 Plucked is identical to all presets in EP73.   The 

Effects panel is covered in detail here.
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TECHNICAL DATA
EP73 Deconstructed was built entirely of recordings of a 1973 Fender 

Rhodes Mk1 Stage 73.

It was recorded at 44.1 kHz, 24 bit,  all channels in mono.

It contains over 13,700 samples and has a compressed size of 

approximately 8.5 GB.
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SUPPORT
If you have any problems or questions relating to the use of this product, 

please feel free to contact us. You can either email us at : 

customerservices@soniccouture.com

or we have a support forum within the KVR Audio community, which can be 

found here :

Soniccouture Support Forum

We will always endeavour to reply to any enquiry within 12 hours, but do 

bear in mind the differences in time zones, so please be patient!
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E.U.L.A.
END USER LICENSE AGREEMENT

PREFACE: This End-User License Agreement ("EULA")  is  a legal agreement 

between you and Soniccouture LTD for the Soniccouture product 

accompanying this EULA, which includes  computer software and may 

include associated media, printed materials, and online or electronic 

documentation ("Software"). By installing, copying, or using the software, 

you agree to be bound by the terms of this  EULA. If you do not agree to the 

terms of this EULA, you may not use the software. 

The software is protected by copyright laws  and international copyright 

treaties, as well as other intellectual property laws and treaties. The software 

is licensed, not sold. 

Soniccouture Ltd grants the Owner of a Soniccouture product the right to

create finished musical works and performances using the sounds and

software that comprise the Soniccouture product.

 

The making of sample libraries in any form, commercial or otherwise,

using Soniccouture audio or software (be they single hits, loops, fully

mixed audio clips, or scripts) is STRICTLY FORBIDDEN without express

written agreement of Soniccouture Ltd, and violations will be prosecuted

to the full extent of international and local copyright law.

 

The ownership of all title and copyrights in and to the Software (including 

but not limited to any images, photographs, animations, video, audio, music, 

text, and "applets" incorporated into the Software ) is fully asserted by 

Soniccouture Ltd.

 

The Owner may only install and use Soniccouture libraries and software

on multiple computers strictly under the following conditions: where

multiple computers comprise part of a single composition workstation for

a composer; or where the Owner has two non-concurrent sites of work,

for example a studio desktop and a laptop for live performance. 

The Owner may not transfer, modify, rent, lease, loan, resell, distribute, 

network, electronically transmit or merge the Software.
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DISCLAIMER OF WARRANTY: The software is provided "as is" and without 

warranty of any kind. The entire risk arising out of the use or performance of 

the software and documentation remains with user. To the maximum extent 

permitted by applicable law, Soniccouture further disclaims all warranties, 

either express or implied, including, but not limited to, implied warranties of 

merchantability and fitness for a particular purpose, with regard to the 

software, and any accompanying hardware. To the maximum extent 

permitted by applicable law, in no event shall Soniccouture be liable for any 

consequential, incidental, direct, indirect, special, punitive, or other damages 

whatsoever (including, without limitation, damages for loss of business 

profits, business interruption, loss of business information, or other 

pecuniary loss) arising out of this EULA or the use of or inability to use the 

software, even if Soniccouture has been advised of the possibility of such 

damages. 
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